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Introduction to Impact/SQL Reconveyance Tracking 

This manual explains all of the functionality contained within the Impact/SQL Reconveyance Tracking 
module, and discusses how each tool might be used.  As each company functions in its own unique way, 
there are some functions that may not be utilized, but you are encouraged to examine and consider all of 
them, to ensure you are getting the most out of Impact. 

 

The Reconveyance Tracking module is utilized by the Title Department to prepare the Notice of Intent 
and Release of Obligations on closed files.  Data entered by Escrow is utilized by the Reconveyance 
Tracking module, so there is no redundant data entry.  Tickler reminders on when to send the Notice of 
Intent and Release of Obligations are used in the Reconveyance Tracking module. 

 

There are a number of configuration options that can affect the functionality of the system.  These 
variations are discussed in this manual, to the extent that the discussion does not detract from the 
explanation of the functions of the complete package. 
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General Information and Helpful Hints 

 

This manual progresses through the functions in Impact Reconveyance Tracking in the order that they 
appear on the menus within the module.  This will not be how you work with the product, as that will 
depend on your responsibilities and the structure of each individual business, as well as the configuration 
of Impact at each business.  Before discussing the system functionality in detail, there are some general 
features that you should be aware of.  These are discussed below. 

 

Some formatting conventions used in this manual are: 

When you need to press the Enter key, you will see ENTER in this manual. 

When you see text displayed on a menu or window such as the words “Edit” or “Cancel”, you will see 
Edit  or Cancel  in this manual. 

Reports > Open List  means that you select Reports from the main menu and then select Open List  
from the next menu. 
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Name Search 

The Name Search  function, seen in many places in Impact, permits you to search the entire Impact 
database by many variables (names, property address, tax parcel ID, escrow number, base number, 
reference number, subdivision, loan number or title file no.).  The index behind the search function, links 
the names in the database to their respective escrow/direct number(s), which permits you to see the 
related escrow/title officer, branch number and (if utilized) title file number. 

 

 

 

 

 

 
 

 

 

 

 

First, before entering a name, select one of the Search Options .  The default Search Option  is to 
search Both Names . 

 

Second, to use the Name Search  function, type in one (1) or more letters or numbers into the Search 
For  text entry field.  You can use the percent symbol (%) as a wildcard, to represent any character. 

 

Click on the Search  button, and if anything is found that matches your search criteria, the results will be 
displayed. 

Type in a search term of one (1) 
or more letters or numbers 
 

Type in a search term and choose a 
Search Option, then click on Search 
 

Choose a Search Option 
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To use one of the displayed results, double-click on it.  Alternately, to change or refine the search, just 
type in a new search term into the Search For  text entry field and/or change the Search Options .  If you 
want to view some additional information concerning one of the escrow numbers listed, highlight the 
escrow number, and then click on Details . 

 

 

 

 

 

 
 

 

 

 

To see additional names if they are available, scroll down through the list of names by clicking on the 
scroll arrow.  Also, if the More>>  button is activated (not dimmed out), you can click on More>>  to see 
even more names than are shown in the first set presented. 

NOTE: If the archive column (far right) has a value in it, the file will NOT be available for viewing 
through Title, as it has been archived. 

 

The Type  column defines the Name on the search line.  The Type formats are: 

B  - Buyer 

S  - Seller 

P -  Property Address 

T  - Tax Parcel 

O - Base Order   

R – Ref number 1 and Ref number 2 

N – Subdivision Name 

The Search For term is “A” 

To scroll up or down, click on the 
scroll arrows 
 

The Search Option 
selected is Both Names 
 

Highlight a name, and then 
double-click to select it 
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Name and Address File (Naf)   

The Name and Address File (Naf) or customer list is a very important tool in Impact.  Whenever the Naf 
is available in the upper left corner of the screen, you may find that it is a very convenient and efficient 
way to fill out the name and address fields.  Try to use it because it speeds up data entry, and provides 
for better sorting of management reports.  Depending on the company’s configuration, you may have one 
centralized Naf or you may have a different Naf for each escrow and title branch.   

 

Any time the Naf is visible in the upper left corner of the screen you can place the cursor within the name 
field to cause the Naf to be activated (not dimmed out).  Click on the activated Naf and then Edit , or 
alternately, just use the CTRL-N Quick Keys to open the Name and Address File  screen.  In the Name 
field, type in a search term of at least one character and Impact will automatically display the results.  
You may also use the percent symbol (%) to represent any character.  Once a Naf entry is highlighted, 
click on Use so that all the completed fields for the Naf entry will populate the fields in the file being 
worked on.  See Naf section for instructions on adding or modifying Naf entries. 

 

 

 

 

 

 

 
 

 

Click on the Use button to paste Naf entry into the name and address fields. 

The Name search term is “century”. 
You may also use the percent 
symbol (%) to represent any 
character. 
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Helpful Hints for Entering Information 

Dates: 

Do not enter hyphens or slashes when entering dates into Impact. 

 

Enter dates as 2 digit month, 2 digit day, and 2 digit year, for example, “122504” for December 25, 2004.  
If entering a different century other than the current century, you must enter a 4 digit year.  You can also 
click on the box with “…“ just to the right of the date entry area, or use the CTRL+D Quick Keys, to pull 
up the Calendar  tool. 

 

 

 

 

 

 
 

Dollars: 

Do not put commas or dollar signs in the dollar amounts. 

Naf: 

Any time you see Naf in the upper left corner of a screen, try to use it (see the discussion of the Name 
and Address File (Naf). 

F4: 

You may use the function key F4 to access a drop down list box, or you may click with the mouse on the 
down arrow. 

TAB: 

Use TAB  to move forward from one entry field to the next entry field. 

  

Use SHIFT+TAB  to move backward from one entry field to the previous entry field. 

Execute: 

When you see a button with dots on the face, you can press ENTER to execute that command, rather 
than clicking on it with the mouse, as the button already has “the focus”.  Press TAB  to move the focus 
to the other button(s). 

 

 

 

For the Calendar tool, click on this 
box or use the CTRL+D Quick Keys 
 

Date entry area 
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Quick Keys 

Quick Keys can help you quickly accomplish tasks by using keyboard entries instead of using the mouse 
to click on selections.  Quick Keys are one or more keys you press on the keyboard to complete a task. 

 

For example, press and hold the Alt key and also the F key.  This ALT+F  key combination opens the File 
menu, just as clicking on the File menu at the top left of the Impact Title screen opens the File menu. 

 

Anytime you see a menu selection item on the screen that has a letter in the word underlined, you can 
use the Quick Keys alternative to using the mouse, for example, use the ALT+ V Quick Keys to drop 
down the View  menu because the “V” in View  is underlined. 

 

 

 

 

Button with dots on the face 
 

Press ENTER to execute “Next” 
 
Press ENTER to execute “Next” 
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Logon 

Access to the Impact Reconveyance Tracking module (as to all Impact modules), is controlled by a user-
rights table, administered by a limited set of user ID’s that have sufficient authority granted to them.  This 
is a very important control, and should be carefully managed.  Depending on the nature of the rights 
assigned to a user, they will have access to various pieces of the overall Impact suite, but generally not 
complete access.  This functionality helps reinforce audit controls, and needs to be considered in 
conjunction with the network security plan. 

 

The system can be configured to require a logon routine, each time the user opens Impact 
Reconveyance Tracking, or it can be configured to provide for an automatic logon utilizing the NT user 
name.  By providing for an automatic logon utilizing the NT user name, control over the access to the 
application is very flexible: both the system administrator and the rights table within Impact can control 
access.  The system administrator can control access by disabling the user’s NT user name, a likely 
event in the case of an employee’s departure. In addition, the user name can be disabled within Impact 
Utilities – which will only affect the user’s ability to access Impact modules.  This would be done if the 
user is still using the rest of the network, but should no longer be accessing Impact. 

 

There is not an automatic expiration of passwords setting within Impact, so to ensure strong controls the 
administrator would have to routinely change all users’ passwords, and inform the users of them, if the 
automatic logon based on NT user names is disabled.  For this reason, the use of an automatic logon 
based on NT user names can be a more effective control – assuming automatic expiration of passwords 
is implemented through the NT operating system.  This matter is more fully explained in the Impact 
Utilities manual. 

 

If the system is configured to require a user to logon to Impact Reconveyance Tracking, a screen like 
that shown below will be presented, after the user double-clicks on the Impact Recon Tracking icon on 
their desktop. 

 

Drop down list 
arrow 
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When configured to require a logon step, the user will be identified within the system by their initials (3 
maximum), and will be given a password. 

 

Enter your user initials in the first field, and then TAB  to the Password  field.  Enter your password and, if 
the correct database is identified in the Log on to  field, click OK.  If the database is not correct, then 
TAB  to the Log on to  field and select the correct database by clicking on the drop down list arrow and 
highlighting a database name; then click OK.  Most users will only have one database available. 

 

Alternatively, if you do not want to use the mouse to click OK, you can hit the TAB  key until OK is 
highlighted, and hit ENTER. 

 

NOTE: When you enter your password, it will not display on the screen, but will be represented by a 
series of asterisks “*”. 

 

If you don’t want to continue, click on Cancel  instead.  This will cause the Logon dialogue box to close 
and the Impact Title module will not be opened. 

 

KEEP YOUR PASSWORD PRIVATE.   You should not share your password or log on to the system and 
then let someone else operate under that session.  The initials of the user logged on to the system will 
attach to transactions entered, and you will only want to be responsible for your own activity. 

 

If you forget your password, the administrator of the Impact application must assign a new one. 
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The Impact/SQL Reconveyance Tracking Desktop 

Impact will display a desktop as shown below when you sign into the Reconveyance Tracking module.  
All menus are accessible without first selecting an escrow or file number.  If a file is opened within the 
Escrow or Title module, you may still access the file in Reconveyance Tracking.   The Reconveyance 
Tracking module does not lock files, so escrow or title may be in the file at the same time. 

Multiple users may enter items into Reconveyance Tracking at the same time.  USA Digital Solutions 
does not recommend multiple users printing the Notice of Intend or Release of Obligation, as this can 
cause some confusion with multiple Notices sent out or recording of the Release multiple times. 

 

 

 

 

 

 

Impact Title desktop may 
show your company logo 
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File Menu 

The purpose of the Reconveyance Tracking system is to aid in tracking payoffs so that the company’s 
Title Department can confirm that reconveyances have been done and to facilitate the recording of a 
release if one has not been done in the required timeframe.   

 

The File Menu will present the following items: 

• New 

• Open 

• Search 

• Exit 

 

New 

Select New will let you open a pre-existing escrow file established through the Escrow module and will 
be new to the Reconveyance Tracking  database.  If the Escrow Number  has already benn added to 
the tracking system, select Open  from the File  menu.  Selecting New will open the Escrow File Number 
Entry  screen.  Enter your Escrow Number  or click on Search  to locate your Escrow Number .  See 
Name Search  on how to find your file number. 

 

 

If your Escrow Number  is not a valid number you will receive the prompt displaying the option of 
entering a different number, like a Direct Order number.  Click on Yes to create a new payoff. 

 

 

Entering a manual number will give you the Items for Reconveyance Tracking screen where you will 
have to manually Add  the payoff information. 
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If your Escrow number or manual number is already in the Reconveyance Tracking System  you will 
receive the prompt to select Open  from the File  menu. 

 

 

 

If you enter a valid Escrow Number, you will receive the Add Items for Reconveyance  Tracking screen 
(seen on the next page) and all the Buyer/Borrower and Seller payoffs entered into the Escrow file under 
the  Payoff sections of the HUD or Worksheet Style of entry, will be listed.  Click on the All tab to load all 
the payoffs into Reconveyance Tracking, or highlight the individual payoffs needed and click on the OK 
tab.   

 

NOTE:  Only payoffs entered into the HUD or Worksheet under the designated payoff screens will 
appear.  This may include credit cards.  Highlight the payoffs needed.  
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Items for Reconveyance Tracking 

 

Once the selected payoffs are highlighted and the OK button selected, the Items for  Reconveyance 
Tracking  screen will appear.  Those payoffs not highlighted will be automatically deleted from 
Reconveyance Tracking. 

 

The following fields may be populated: 

• Escrow Number  – the Reconveyance Tracking  file number 

• Branch Number  – the branch the Escrow Number  was assigned too  

• Escrow Officer  – the assigned Escrow Officer of the Escrow Number  

• Close of Escrow  – the actual closed date of the escrow file.  This is the date the revenue / 
transfer slip was printed in escrow.  If a Close of Escrow  date was not previously entered from 
the Escrow module, the system allows one to be entered here.  Entering a Close of Escrow  
date in Reconveyance Tracking  does NOT update the close date in Escrow.  Enter the date in 
mmddyy format or click on the box with “…” just to the right of the date entry area, or use the 
CTRL + D Quick Keys to pull up the Calendar tool. 

• Recording County  – the county the property is located in.  If a Recording County  was not 
previously entered from the Escrow module, the system allows one to be entered here.   

• Date Entered  – The date the file was added to the Reconveyance Tracking  system. 

• Payee  - The name of the payoff lender 

• Address – The address of the payoff lender 

• Location -  The city, state, and zip for the payoff lender 

• Loan # - The loan number for the payoff 

• Amount – The payoff amount disbursed from the escrow file. 

 

NOTE:  Fields entered into Reconveyance Tracking  do NOT update the fields in the escrow file.  
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You may Add  additional payoffs to the Items for Reconveyance Tracking , Modify  the existing payoffs 
selected from the Add Items for Reconveyance  Tracking screen, Delete  the payoffs, or Cancel  to exit 

the screen. 

 

To modify an exiting payoff, highlight the payoff Payee and click on the Modify  button and the 
Reconveyance Update  screen will appear. 
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Reconveyance Update 

Some fields will be populated with information from the escrow file.  The Reconveyance Update  screen 
allows entry for the following fields: 

• Escrow Number  – the Reconveyance Tracking  file number 

• COE Date – The close of escrow date is the date the revenue check / transfer slip was printed.  
Enter the date in mmddyy format or click on the box with “…” just to the right of the date entry 
area, or use the CTRL + D Quick Keys to pull up the Calendar tool. 

• Notice Sent  – The date the Notice of Intent was set. 

• Release of Obligation – The date the release was set. 

• Beneficiary, Trustor, Trustee, Other #1, Other #2, Owner, Legal, and Comments  

 

Original Recording Information 

The Original Recording Information  is from the original Deed of Trust, Mortgage, or instrument that is 
being released.  The following fields may appear on the Notice of Intent sent to the parties involved.  The 
fields available for the Original Recording Information are: 

 

• Document #  - The Document # is required for the file to appear on the Notice of Intent ticklers. 

• Date Recorded – The original date the Deed of Trust, Mortgage or other release document was 
recorded.  Enter the date in mmddyy format or click on the box with “…” just to the right of the 
date entry area, or use the CTRL + D Quick Keys to pull up the Calendar tool. 

• Docket # - The original Docket  book assigned by the county recorder’s office. 

• Book – The original Book  number assigned by the county recorder’s office. 

• Page – The original Page number assigned by the county recorder’s office.  

 

Reconveyance Recording Information 

The data for the Reconveyance Recording Information  is entered at least thirty (30) days after the 
Notice of Intent letter has been sent and the Release has been recorded.  The fields available are: 

 

• Document # 

• Date Recorded 

• Docket # 

• Book  

• Page 

 

Parties Involved 

The tab folders represent the parties involved, the brief legal description of the property and any 
comments you will like to add to the file.  You may access the parties by clicking on their tab folder or 
use the Alt + the letter underlined from your keyboard.  The Alt + L will display the Legal screen. The tab 
folders are: 

• Beneficiary 

• Trustor 
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• Trustee 

• Other #1  

• Other #2  

• Owner 

• Legal  

• Comments 

Beneficiary 

The Beneficiary  screen may be populated with information from the escrow file.  The following fields are 
available for the Beneficiary  information. 

 

• Beneficiary Name – The seller number one and seller number two names from the escrow file.   

• Name – The payoff lender name from the escrow file is loaded, else you may use the Name and 
Address File, the NAF, to populate the payoff lender fields.. 

• Address 1 – The payoff lender address line one from the escrow file 

• Address 2 – The payoff lender address line two from the escrow file. 

• City, State, and Zip – The payoff lender location from the escrow file. 

• Loan # - The payoff lender loan number from the escrow file. 

• Type of Instrument – The Type of Instrument  is not available if the system configuration 
Select State  is set for Nevada under the Tools menu.  If you have the field Type of Instrument , 
select the type of document you will be releasing, Other, Deed of Trust, or Mortgage.  If no 
Type of Instrument  is selected, a Notice of Intent  will not be generated. 

• Date – The date the payoff check was issued. 

• Amount – The amount of the payoff check. 

• Check # - The check number issued for the payoff. 

 

Trustor, Trustee, Other # 1, Other #2 

The Trustor,  Trustee,  Other #1 , and Other #2  allow for the name and address of the involved parties.  
You may use the NAF to populate the fields.  The Trustor name must be entered. 
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NOTE: When there is an entry in the Name field below any of the tabs a red diamond will appear to the 
left of the title on the tab. 

Owner 

The Owner  screen will load the buyer number one name from the escrow file.  You may edit the Owner 
name. 

 

Legal 

The Legal  screen will load the brief legal from the escrow file.  You may edit the Legal . 
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Comments 

The Comments  screen will allow you to enter any comments about the file. 

 

NOTE:  Fields entered into Reconconveyance Tracking  do NOT update the fields in the escrow file.  

 

Open 

The Open  feature allows you to reopen an existing file previously established in the Reconveyance 
Tracking  module.  When you select Open  the Reconveyance Open  screen will appear.  Enter your 
Escrow Number  and click on OK to open the Items for Reconveyance Tracking .  (See the Items for 
Reconveyance Tracking  section).  You may then Add, Modify, Delete  any new or existing payoffs, or 
cancel  to return to the desktop. 

 

 

 

Reconveyance Search 

If you do not know your Escrow Number  click on Search .  The Search  screen will appear where you 
can search by Name ( the payoff company name), CheckNo  (the payoff check number generated from 
escrow), or the Document No  ( the Document # from the Original Recording Information).  Note: this is 
NOT the same Name Search screen reached from the Search button on the New File Entry screen. 
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Search (Reconveyance Search) 

The Search  feature allows you to search all files existing in the Reconveyance Tracking  database. 

Select Search  and the Reconveyance Search  screen will be displayed.  You may search on a Name 
(the original lender paying off), CheckNo  (payoff check disbursed in escrow), Escrow No  (only files 
established in the Reconveyance Tracking  module), or Document No  (the Document #  from the 
Original Recording Information ).  Select your Search Option , then enter your information in the 
Search For  box.  Click on the Search  button to continue or Cancel to return to the Reconveyance 
Tracking  desktop.  Highlight your file and double click to receive the Reconveyance Update  screen. 

 

Exit 

The Exit  function will close the Reconveyance Tracking  module and return you to your desktop. 
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View Menu 

The View menu will allow you to display and print an escrow ledger of all the funds receipted in and 
disbursed.  The Escrow Ledger  is displayed to verify that the payoff check(s) were disbursed.  The file 
does not have to be entered into the Reconveyance Tracking  module to display an escrow ledger.  
Select Escrow Ledger  from the View  menu. 

 

Enter your Escrow Number  in the text box  and click on OK to display the Escrow Ledger , or click on 
Search to find your file (See the Name Search  section on how to use this function).  Click on Cancel to 
return to the Reconveyance Tracking  desktop. 

Escrow Ledger 

The ledgers show monies coming in and going out from an escrow file. 

 

After selecting OK from this dialogue box the Regular Ledger screen will open. 

The Regular Ledger  will be presented, as shown here.  General information about the file (Escrow 
Number, Escrow Officer, Branch, Bank currently assigned, and Buyer and Seller names) is presented 
on the top left of the screen, and summary accounting figures are presented on the top right.  The 
Posted Balance  is modified with the work in process  and on hold  to result in the Available Balance  – 
which is what is left in the file to be disbursed 

 

At the middle of the Regular Ledger screen are three (3) tabs, Posted Items , Receipts in Process , 
and Disbursements In Process .  To switch from the Posted Items  tab to the Receipts in Process (or 
any other) tab, click on the Receipts in Process  (or any other) tab with the mouse, or use the ALT+ 
character  Quick Keys. 
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NOTE: There are three tabs on this screen: Posted Items, Receipts in Process and 
Disbursements in Process.  Click on the tab heading to move from one to the other. 

 

The ledger presents, for each transaction, from left to right: 

 

The date of the transaction; they are presented in date order 

The type (receipt or disbursement) and source (bank  account number); if the file has switched 
banks, you will see different source numbers on som e of the items. 

Who entered the item (user’s initials) 

The payor of a receipt or the payee on a disburseme nt 

The receipt type (only on receipts) 

The reference number of the item (receipt number or  check number); an “M” beside the check 
number denotes it was a manually prepared check; a “C” beside a check number indicates the 
check has been cleared, through a reconciliation; a n “H” will appear on a receipt that is on hold 
(remember: only Accounting can release non-current- date holds), and a “V” will reflect a Void. 

The amount (either in the receipts column or in the  disbursements column, as appropriate 

And the running balance through each transaction  

View Check 

If you highlight a disbursement ledger item you may view the detail information of the check  

 

 

The View Check will display the following information. 

• Escrow Number 

• Bank  the check was drawn on 

• Branch  the Escrow Number was assigned to 

• Date the check was issued 

• Amount  of the check 

• Payee Name  and Address 
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• Memo Line  

• Print Queue  – The name of the printer on which the check was printed. 

Savings Ledger 

The Savings Ledger  shows financial information for interest bearing accounts linked to an escrow.  A 
file may or may not have a savings ledger .  If a savings account is attached to an escrow file you will 
have a Savings  button at the bottom of the ledger screen. 

 

Click on the Savings  button, to open the Savings Ledger . 

 

Highlight the desired savings account and then click on OK, or simply double-click on the item to open 
the Savings Ledger  screen.  Alternatively, click on Cancel to return to the Impact desktop. 

The Savings Ledger  will display and print who the savings account was Opened For,  a specific entity.  
The name of the entity is taken from the information entered within the Name field when the savings was 
set up. The Opened For  information is useful when multiple savings accounts are opened under one 
escrow. 
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To print the ledger, click on Print  to open the print dialogue box, where you can click the appropriate 
button to print (OK), Preview the ledger before printing, or Cancel  to return to the previous screen. 

 

Click on Cancel  to return to the Reconveyance Tracking  desktop. 
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Reports Menu 

The Reports menu will generate the following reports: 

 

• Open List 

• Notice of Intent    

o Ticklers 

o Print All 

o Print Specific 

o Set Notice Sent Date 

• Release of Obligation 

o Ticklers 

o Print All 

o Print Specific 

o Set Release Sent Date 

 

Open List 

The Open List Report  will list all files entered into the Reconveyance Tracking  module. 

The Open List Report  will give you three print options, Sort by Escrow Number , Sort By Recording  
Date, or Sort By Escrow Officer .  Click on the radio button to generate the report for a specific sort 
option.  After selecting the report Print Option  click on the OK button for the print dialog box to appear, 
where you can preview or print the Open List .  

 

The Open List Report  will show the Escrow  number, the Branch  the escrow file is assigned to, the 
Recorded  date (the Close of Escrow Date ) and the payoff Name. 
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Notice of Intent 

Ticklers 

The Ticklers  give a listing of all Reconveyance Tracking  files that do not have their Notice of Intent  
Date set and are “x” number of days either from the COE Date or the Date Entered  into the 
Reconveyance Tracking  module.  Your system configuration determines whether the Notice of Intent  
Date is based on the COE Date or the Date Entered  into Reconveyance Tracking  and the number of 
days from the date to trigger the tickler. 

 

Select Ticklers  to generate the print dialog box.  If there are no entries to print you will receive the Print 
Notice of Intent Ticklers  prompt.  Press OK to return to the Reconveyance Tracking  desktop. 

 

 

NOTE:  You will receive the Print Notice of Intent Ticklers  prompt above if your reconveyance file does 
not have a Document #  entered in the Original Recording Information  and/or information was not 
entered into the Reconveyance Recording Information  area in the Reconveyance Update  screen.. 

 

 

Entries on the Ticklers  are ready to have the letter for the Notice of Intent  created. 

The Ticklers  will show the Escrow number, Recorded  date and Document Number/Book & Page  
from the Original Recording Information  and the recording County from  the Items for 
Reconveyance Tracking  screen. 
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Print All 

The Print All  feature will generate the letter of Intent, a copy of the Release for all parties involved, plus 
a check list of parties involved with mailing labels for the files listed on the Notice of Intent Ticklers. 

Select Print All  and you will receive the Notice of Intent  prompt.  Click on Yes to generate the notices 
or click on No to return to the Reconveyance Tracking  desktop. 

 

 

The Notice of Intent  and Release  is customized for each Title Company. 

The Check Off List  shows the parties receiving a Notice of Intent  and copy of the Release  for each 
file. 

The laser generated mailing labels prints three labels for each party receiving the Notice of Intent . 

 

NOTE:  If no Type of Instrument  is selected in the Reconveyance Update  screen, then no Notice of 
Intent  will print. 
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Print Specific 

You may print a specific Notice of Intent  on any file.  Select Print Specific  and you will be prompted to 
enter your Escrow Number .  Click on Search if you do not know your file number. (See section on 
Reconveyance Search ).  Click on OK to receive the Print Specific Notice of Intent  screen or Cancel  
to return to the Reconveyance Tracking  desktop. 

 

 

The Print Specific Notice of Intent  screen will display all the payoffs entered for your Escrow Number .  
If a Notice Date  or Release Date  was previously entered they will be displayed along with the payoff 
Name. 

Check the box for each Notice of Intent  you want to print.  The Notice of Intent  and a copy of the  
Release  will print for all parties involved, plus a check list  of parties involved with mailing labels for the 
file. 

After you print the specific Notice of Intent  you will be prompted to set the Notice Sent Date .  Click on 
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Yes to update the Notice Sent Date  or click on No to return to the Reconveyance Tracking  desktop. 

 

Set Notice Sent Date 

The Set Notice Sent Date  will allow you to update the Notice Sent Date  on all files that appeared on 
the Notice of Intent Ticklers .  You do not have to print the Notice of Intent  to update the Set Notice 
Sent Date . 

 

Release of Obligation 

Ticklers 

The Ticklers  give a listing of all Reconveyance Tracking  files that do not have their Release of 
Obligation Sent  date set and are “x” number of days from the Notice Sent  date.  The number of days 
from the Notice Sent  date is a system configuration. 

 

Select Ticklers  to generate the print dialog box.  If there are no entries to print you will receive a prompt 
stating no Release of Obligations  to print.  Press OK to return to the Reconveyance Tracking  
desktop. 

Print All 

The Print All  feature will generate the Release of Obligation  document for each payoff listed on the 
Ticklers . 

Select Print All  and you will receive the Release of Obligation  prompt.  Click on Yes to receive the 
printer dialog box and generate the releases or click on No to return to the Reconveyance Tracking  
desktop. 

 

 

After the releases are printed you will be prompted to update the Release Sent Date .  Click on Yes to 
update the Release of Obligation Sent  date or No to return to the tracking desktop. 
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Print Specific 

You may print a specific Release of Obligation  on any file.  Select Print Specific  and you will be 
prompted to enter your Escrow Number .  Click on Search if you do not know your file number.  (See 
section on Reconveyance Search ).  Click on OK to receive the Print Specific Release of Obligation 
screen or Cancel  to return to the Reconveyance Tracking  desktop. 

 

The Print Specific Release of Obligation screen will display all the payoffs entered for your Escrow 
Number .  If a Release Date  was previously entered they will be displayed along with the payoff Name 
and the Notice Date . 

 

Check the box for each Release  you want to print.   

 

After you print the Release  you will be prompted to set the Release of Obligation Sent date.  Click on 
Yes to update the release date or click on No to return to the Reconveyance Tracking  desktop. 

 

Set Release Sent Date 

The Set Release Sent Date  will allow you to update the Release of Obligation Sent date on all files 
listed on the Release of Obligation Ticklers .  You do not have to print the Release of Obligation  to 
update the Set Release Sent Date . 

 

Get INGEO Releases 

This option not in use. 
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Tools Menu 

The Tools Menu will allow you to configure the Reconveyance Tracking  system on when to send the 
Notice of Intent  and when to record the Release of Obligation .  You will also have the option of 
purging all files from the Reconveyance Tracking  module which have met certain requirements. 

 

The Tools Menu will present the following items: 

• Purge 

• Configuration Options 

• Type of Document Table Maintenance 

 

Purge 

The Purge  option will allow you to delete files from the Reconveyance Tracking system.  Enter the 
Purge Through Date  and click on OK, else click on Cancel  to return to the  
Reconveyance Tracking  desktop.   

 

All files with a Release of Obligation Sent date set on or before the Purge Through Date  or all files 
with the Reconveyance Recording  Information Date Recorded  set on or before the Purge Through 
Date will be deleted from the Reconveyance Tracking system. 

Configuration Options 

The Configuration Options  allow the Title company to configure the Reconveyance Tracking  system 
based on the date the file was entered into Reconveyance Tracking  (Date Entered ) or the date the file 
was closed (Date File Closed ) within the Escrow module, along with the number of days before a file will 
appear on the Notice of Intent  Ticklers and Release of Obligation  Ticklers . 

 

The Configuration Options  screen will display the following configurations: 

• Select State: 

• # Days Intent: 

• #Days Release of Obligation 

• Enable INGEO Export 

• Select option to use for # of Day Calculations 

o Date Entered 

o Date File Closed 
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Select State 

Select Arizona  or Nevada .  Arizona  will require a Type of Document Table . 

 

# Days Intent 

Enter the number of days from Date Entered  or Date File Closed  you would like to have your file 
appear on the Notice of Intent  Ticklers . 

 

# Days Release of Obligation 

Enter the number of days from the Notice Sent  date you would like to have your file appear on the 
Release of Obligation  Ticklers . 

 

Enable INGEO Export 

This function is not available. 

 

Select option to use for # of Day Calculations 

Date Entered 

Selecting Date Entered  will base the # Days Intent  from the date the file was inputted into the 
Reconveyance Tracking  system. 

Date File Closed 

Selecting Date File Closed  will base the #  Days Intent  from the escrow closing date. 

 

Click on the OK button to retain your entries, else click on Cancel  to return to the Reconveyance  
Tracking  desktop. 
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Type of Document Table Maintenance 

 

The Type of Document Table Maintenance  option is only available if Arizona  is selected for the state.  
This table appears on the Reconveyance Update  screen for Type of Instrument .  The Type of  
Instrument  is the name of the release that will be recorded. 

The Document Types Table Maintenance  will allow you to create a New entry, Modify  an existing 
entry, Delete  an existing entry, Cancel  to return to the Reconveyance Tracking  desktop or OK to retain 
you changes. 

New 

Click on New to open the Document Types  screen.  Enter a unique one character number for the 
document Number .  Enter the name of the document in the Description  field.  Click on the OK button to 
save your information and return to the Reconveyance Tracking  desktop, or click on Cancel to return to 
the Reconveyance Tracking  desktop. 

Modify / Delete 

Highlight an entry in the Document Types Table Maintenance  screen and click on Modify  to change 
the Description  or Delete to remove the entry from the table.  Click on OK to save your changes and 
return to the Reconveyance Tracking  desktop, or click on Cancel to exit the table. 
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Naf Menu 

The Name and Address File (Naf) or customer list is a very important tool in Impact.  Depending on the 
company’s configuration, there may be one centralized Naf or a different Naf for each branch.  The 
Name and Address File (Naf) is displayed in a tiered manner: Company – Branch - Individual.  This 
provides a good way to show the relationship between an individual and where he/she works. 

 

The NAF menu consist of: 

 

Add and Modify  Ctrl+N 

Print 

Add and Modify 

Maintenance of the Naf is done through this menu, if you have authorization to change the Naf.  The Naf 
can be centralized or branch-specific, depending on system configuration.  The Naf can also be limited 
as to whom is permitted to edit it. 

 

In the Search for Name starting with  field, type in a search term of at least two (2)characters, and 
Impact will automatically display the results, or you may use the percent sign (%) as a wildcard 
character. 

 

You may narrow your search by selecting one of the 8 Search Options  and/or search parameters, by 
Name, ID, county, or state.  You may check the Expand box and see any relationships to the company 
name that have been added. 

 

NOTE: If you are not authorized to edit the Naf then the New, Modify  and Delete  buttons will be 
deactivated (dimmed out). 
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In the search results display, the company entries are bolded, branch entries are not bolded and 
individuals’ entries are italicized for enhanced readability. 

 

New 

You can add a new Naf entry by clicking on the New button.  Impact will display a prompt asking if you 
would like to: add a new Company, add a branch under the Company currently selected, add an 
individual user under the Branch selected or add an individual user under the Company.  Based on your 
selection you will be presented with an empty form on the right side of the NAF screen.  Complete the 
form with as much information as is available.  Click on Save to accept your entries, or on Cancel  to quit 
without saving.   
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By clicking on the New button the New NAF Entry  form is opened. 

 

In the updated screen below, the left side of the screen shows the completed set of data for 

the Company with a branch, branch users, company users and a second company listed. 

Modify 

 

To make changes to a Naf item, highlight a name and then click on Modify  to open the Modify Name 
and Address  screen.   

 

Select one of the Search Options , then modify fields as needed on the rest of the screen.  Depending 
on system configuration, an automatic Id No  can be assigned to each customer.  The automatic ID No‘s 
are useful to coordinate customer numbering with an outside accounting system.  The Comments  area 
of the screen can be used for information for which there are not fields. 

 

At the bottom of the screen the Naf has fields available for a Bank Name , Account Number  and 
Routing Number .  This is useful information to have filled out before wiring money.  The bank Routing 
Number  must be a valid receiving bank ABA number or Impact will not accept the routing number.  
While bank routing numbers are downloaded from the Federal Reserve website and updated by the 
system administrator periodically, in order to validate ABA #’s on wire entries, the entries in the NAF are 
NOT updated by the ABA downloads, nor validated when entered here. 

 

The NAF function allows the user to flag a NAF record as Inactive.  Setting a Company level record as 
Inactive, sets all related parties as Inactive.  Setting a single related party as Inactive will dim the 
specific entry and still allow the user to use the Company level record and any other records not set as 
Inactive . 
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Click on Cancel  to abort any changes and return to the Name and Address File  screen, or Save to 
save any changes or new entries to the screen.    

 

Delete 

Delete  will delete the entire Naf entry (a dialogue box will ask for confirmation). 

Print 

A name and address listing can be generated for any or all of the Naf categories.  By default, in the Print 
Options  area of the screen, all the fields are checked. Place the cursor on a check box, and uncheck 
any categories that should not be printed. 

 

Click on OK to print, or Cancel  to abort any changes and return to the 
Impact desktop. 

 

Optionally, click on OK, then on Preview . From this preview screen, 
these print results can be exported to a file (click on the envelope-
with-arrow icon on the top left corner of the screen), for example a 
.CSV file, and used in Microsoft Word via the Tools  > Letters and 
Mailings  > Mail Merge  function, for seasonal greeting cards, mass 
mailing, etc.  
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About Menu 

To determine the Impact Title module version and build number, select this menu option.  Please have 
this version number information available when calling the Help Desk for assistance. 

 

 

 

 

 

 

 

 

 

 

NOTE: The build number for each Impact/SQL module may be different from another Impact/SQL 
module, for example, the Escrow module may not be the same build as the Title module. 

 

 

Version number information 
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Appendix A - Troubleshooting 

 

USA Digital Solutions Support personnel may ask that you make a screen shot so that you can e-mail 
Support a “picture” of the screen as it appears when the error occurs. 

 

To create this screen shot and save it for the Support personnel: 

 

Press the Print Screen  key on the keyboard, which is usually located on the top row of the keyboard, 
and is usually the third key from the right. 

At bottom left of your screen, click on the start  button.  From the menu, select New Office Document . 

After the Microsoft Word application starts, go to the top left of the screen with the cursor and from the 
menu select File  > New. 

As soon as Microsoft Word opens a new document, go to the top left of the screen with the cursor and 
from the menu select Edit  > Paste. 

After the screen shot is pasted into the document, go to the top left of the screen with the cursor and 
from the menu select File  > Save.  Save this document in a location from where you can send it as an e-
mail attachment (navigate to wherever you put non-Impact Microsoft Word documents).  You will have to 
remember the path and the document name in order to locate this document later. 

After the document is saved, go to the top left of the screen with the cursor and from the menu select 
File > Close to close Word.   

Return to your Impact session, and finish the current process. 

Now e-mail the saved document as an attachment, via your normal e-mail routine, to the email address 
provided by USA Digital Solutions Support personnel.  USA Digital Solutions Support personnel can be 
reached at (602) 866-8199 extension 2. 


